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What is HM Find+Rename Vers. 11 Q

HM Find+Rename is an easy to use and powerful rename utility for files. HM Find+Rename is
fast and therefore best qualified for renaming a large number of files too.

With HM Find+Rename you can find and rename files in a folder and its subfolders in any way.
HM Find+Rename is useful for renaming a large number of files with similar filenames according to
a certain pattern.

For example, if you copy the files of a web site from your browser cache to a folder on your disk
and you wish to remove the automatically inserted numbering of the files (xxxx[1].yyy), HM
Find+Rename can help you with one single renaming action for all files in a folder and its
subfolders. Or another example: if you manage a large number of JPEG, MPEG or MP3 files, you
can number the files or change an existing numbering of the files by renumbering.

For finding the files enter a search pattern matching the filenames either with simple wildcards (*
and ?) or with complexer regular expressions.

For renaming the files enter a supplementary replace pattern, possibly containing simple replace
expressions which can refer to temporary character buffers containing matching results of
subexpressions of the search pattern. Therefore you can do complexer renaming actions too. With
one single renaming action you can rename either one single file found or a sequence of files
found in a folder and its subfolders.

Frequently used search and replace patterns can easily be stored persistently, and can be
recalled later easily and fast by a popup menu.

Moreover, with HM Find+Rename you can successive number found files (ascending or
descending) and change file names to upper/lower case or mixed formatting as well as change
file properties (creation date, modification date, last access date, the file attributes Archive,
Hidden, System and Read-only).

HM Find+Rename is provided with a Preview function for testing the desired rename actions.
Additionally, HM Find+Rename has a powerful Undo function. You can undo all modifications
since last find action.

Just like in Windows Explorer you can sort the displayed file list of HM Find+Rename by file
attributes. You can select a file to edit the filename or to run a command from the file's context
menu as defined for this file type by Windows. You can select one or more files to copy or move
them to another folder using the Windows clipboard or by drag & drop.

Some examples with wildcards:

Search pattern Replace pattern Matched file will be renamed to

*[?].* R Name[1].htm Name.htm

*.txt & Name.txt Name

& XY-* Name.txt XY-Name.txt

XY-* & XY-Name.txt Name.txt
Maria.gif Pic008.gif

* . gif Pic:(008).gif Monica.gif Pic009.gif

Martha.gif Pic010.gif
Text-1.doc 1-Text.doc

A \2-\1.* Text-1.gif 1-Text.gif
Text-2.doc 2-Text.doc

Some examples with regular expressions:

Search pattern Replace pattern Matched file will be renamed to
Name[1].htm Name.htm
ACENLO-91HAN () b NameEl]Z].htm Name.htm
Maria01.gif Maria001.gif
A(X[N0-9])[0-9]*\.gif \1:(001).gif Monica.gif Monica002.gif
Martha02.gif Martha003.gif
AR All files containing at least one "a".
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Program Version 1.1.7 (= 1.1 SP7) - 11 May 2014
More Input Comfort

e If the search action displays an error message for a folder (e.g. "access denied") then, in the
displayed error message box, the user can choose now to suppress this error message for all
further folders.

Bug Fixes

Under Windows 9x up to and including Windows 2000 the context help popup windows (tips)
did not work anymore as of HM Find+Rename v1.1.6.

Under Windows Vista/7/8 64bit the menu commands of the "Send To" submenu of a file in HM
Find+Rename's file list failed.

If ENTER was pressed after input of a search pattern into the "Search" field then sometimes a
previously used search pattern was shown in "Search". But the search action was performed
correctly with the new search pattern.

Workaround added for a bug in the Microsoft Windows API. A wildcard search with a file
extension with three characters (e.g. "*.htm") did not just find the files with this file extension
but also all files with longer file extensions starting with the file extension searched (e.g.
".html").

Note: If necessary, you have to modify manually your stored wildcard search
patterns if you need the previous search behavior (e.g. "*.htm*"),

¢ Workaround added for a bug in the Microsoft Windows API. As of Windows 2000 the ? wildcard
search is buggy and delivers different results depending on the character position in the
search pattern. The ? wildcard is defined as a placeholder for any single character. But for
example at the end of a file extension the ? wildcard accepts any single character OR NO
CHARACTER. Example: The search pattern "*.ht?" should find all files with a file extension of
three characters and starting with "ht". But under Windows 2000 and newer the Windows API
delivers additionally all files with the two character file extension ".ht". The workaround filters
all false found files.

Note: If necessary, you have to modify manually your stored wildcard search
patterns if you need the previous search behavior (e.g. "*.ht*" or an appropriate
regular expression).

e Workaround added for a bug in the Microsoft Windows API. If a wildcard search pattern begins
with a * wildcard and searchs for any file extension (e.g. "*t.*") then the last part of the
search pattern (".*") is ignored completely. For example, "*t.*" finds "at.htm" (correct) but
also "ab.txt" (false). The workaround filters all false found files.

Note: If necessary, you have to modify manually your stored wildcard search
patterns if you need the previous search behavior (just delete the part ".*" at the
end of the search pattern).

¢ Workaround added for a problem with the Microsoft Windows API. If a particular icon handler
is installed for a file type, the "Last Access Time" of a file is updated when accessing the meta
data of that file, even though the file itself is actually not accessed. For example, this case
occurs for html files when Microsoft Office is installed on the system. So, if in HM
Find+Rename the "Last Access Time" of such files were modified and after that the file list of
HM Find+Rename was refreshed by a find re-run, the "Last Access Time" was updated again
with the current date and time by the icon handler. The workaround ensures that a find run in
HM Find+Rename doesn't modify the "Last Access Time".

Minor Tweaks

¢ The help on "Entering Replace Patterns" is improved slightly.
e New Homepage and email forwarding addresses.

Program Version 1.1.6 (= 1.1 SP6) - 30 Aug 2011
Minor Tweaks

e New Homepage and email forwarding addresses.
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e Improved What's This help in the application's main window.
¢ Some minor source code optimizations.

Program Version 1.1.5 (= 1.1 SP5) - 07 Sep 2009
Minor Tweaks

e Modified Shareware restrictions for the unregistered version of the program.
¢ New Web links to the product page and online order page of the Share*It! Online-Shop.

Program Version 1.1.4 (= 1.1 SP4) - 07 Aug 2009
Additional Functions

e Improved compatibility with Windows Vista and newer Windows versions.

e Program option ' File List - Maximum Size' on the 'General' options tab accepts now the value
0 causing the file list to have no maximum size.

e On the 'General' options tab there is the new program option 'Auto-display of context help
popup windows (tips)'.

More Input Comfort

e The graphical user interface of HM Find+Rename is improved (some field labels weren't fully
readable) and its "Look & Feel" is adapted to Windows XP and Vista style.

e The keyboard shortcut for saving a new pattern within the input fields 'Search' and 'Replace’
has been changed from 'Ctrl+Ins' to 'Ctrl+Shift+Ins' because 'Ctrl+Ins' in input fields is the
standard shortcut for 'Edit » Copy' in some Windows applications.

e The keyboard shortcut 'Alt+H' now opens the Help menu from the Menu Bar. For triggering the
previous meaning of 'Alt+H' (cancel a running Find, Rename or Change action) now, please
use the 'Esc' key or just press 'Enter' or 'Return’.

e The ten most recent values entered into the input fields 'Folder', 'Search' and 'Replace' are no
longer saved just temporarily but also persistently now and, therefore, are available again
after a restart of the program.

¢ In the 'Dates/Attributes' program view the input fields for specifying the new date and time
within the group box 'New File Times' have been simplified.

Bug Fixes

e Under Windows XP and Vista double-clicking a file in the file list didn't work (Open command
of the file).

e Under Windows Vista the program crashed when displaying the sub menu "Open With" of the
context menu of a file in the file list, because Vista returns an invalid parameter value.

¢ Under Windows Vista HM Find+Rename's Help and Context Help didn't work anymore because
Vista doesn't longer support Win32hlp, the help system of previous Windows versions. Now
HM Find+Rename's Help is implemented with HTML Help, the new Windows help system.

e Under Windows Vista the uninstaller of the previous versions of HM Find+Rename failed unless
it was launched by a user logged in with administrative privileges and by the context menu
command "Run as administrator". Now installation and uninstallation is always automatically
launched with administrative privileges.

e Search/replace patterns didn't work properly with non-ASCII characters (German umlauts,
etc.), for example in upper/lowercase conversion.

Program Version 1.1.3 (= 1.1 SP3) - 18 Apr 2002
Bug Fixes

¢ Under certain hardware configurations (low screen resolution, standard graphic driver, ...) the
date input fields of the 'file attribute view' were displayed too small. That is why, for example,
the year was not completely displayed and moreover couldn't be entered.

e Under certain hardware configurations (low screen resolution, standard graphic driver, ...)
some static texts were not completely displayed in several windows and dialogs.

e Under certain hardware configurations (low screen resolution, standard graphic driver, ...) the
main window was displayed too small after program start (not adapted to the size of the
displayed view).
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Program Version 1.1.2 (= 1.1 SP2) - 29 Jun 2001
More Input Comfort

¢ Now the browser window for selecting the search folder remembers the last entered/selected
search folder on opening.

Bug Fixes

e Bug: If Windows Explorer is configured not to display the extensions of filenames, HM
Find+Rename don't display the extensions too, having the aftereffect that rename actions do
not find the files to rename (the message 'O file(s) renamed' is displayed after each rename
action). Fix: Now HM Find+Rename displays filenames always including the extension.

Program Version 1.1.1 (= 1.1 SP1) - 07 Mai 2001
Bug Fixes

e Bug: If program option 'Rename All: resume the Rename All / Change All action at the next
file' is activated, in some cases, if a file could not be renamed, the rename action is not
continued at the next file but at the same file, so that the same error message is displayed
again and again. This bug occurs only with the version 1.1.

Program Version 1.1 - 01 Apr 2001

Program version 1.1.0 provides the following innovations:
Additional Functions

* Now it is possible to change the following file properties of one or more files with one single
action:
- Creation date, modification date, last access date,
- File attributes (Archive, Hidden, System, Read-only).

e Now Undo function is applicable to direct editing of a file name in the file list too.
New Menu Items

e Edit - Select All (applies to the file list and all edit fields).

e Edit - Invert Selection (in the file list only).

e View - Find/Rename (shows the program view for renaming of files).

¢ View - Dates/Attributes (shows the program view for changing the file properties).

e View - Options (contains an additional register for the management of the persistent
search/replace patterns).

New Function Keys

¢ F2 (in the file list only): Edit the file nhame of the selected file.

e F4 (in the input fields Search Folder, Search and Replace only): Shows the dropdown list.

e F5: Restart the Find action.

e ESC: Cancel a running search, rename or change action (same as clicking the Stop button).

More Input Comfort

¢ Now the most important input fields (Search Folder, Search, Replace) automatically store the
user input in a dropdown list until the end of the program session.

e Often used search and replace patterns can now be stored persistently and can be recalled
easily and fast by a popup menu.

e New edited search and replace patterns can easily be added to the persistent search/replace
patterns by entering CTRL+INS in the input fields "Search" or "Replace".

e Simple wildcards and regular expressions are preconfigured as persistent search/replace
patterns.

File List
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e Multi-selection possible (that means, multiple or all files in the file list can be selected, just like
in the Windows Explorer).

e F2: Edit the file name of the selected file.
e CTRL+C / CTRL+X: Copy/Cut the selected files to the Windows clipboard.
e Drag & Drop for the selected files (Copy/Move the files into an other folder or application).

o If the input focus is in the displayed file list and one or more files are selected, pressing the
ENTER/RETURN key now opens the selected files (just like in the Windows Explorer) in
contrast to the previous behavior of restarting the Find action (note, to restart the Find action
at any time now use function key F5).

Bug Fixes

e Bug: A File directly edited in the file list after that is sorted with the old file name.

e Bug: If check box "Whole List" is unchecked and "Rename All" action does not find a matching
file starting at the current selected file to the end of the file list, "Rename All" continues the
search at the beginning of the file list.

e Bug: In some cases the action buttons are not properly activated/deactivated.
Better License Terms

e On damage or lost of your bound volume (= licensed disk) or if you substitute your hardware
you can request for a free follow-up license.

e For companies which would like to use the program on multiple workstations we offer low-cost
and easy to handle multi-user licenses.

HM Find+Rename USER MANUAL Page 8 of 88



- - HM Find+Rename |2,
Notes on Windows Vista and later Vers. 11 Dz

HM Find+Rename with standard access rights (recommended)

If you have activated the user account control (UAC) under Windows Vista and later (default
setting), HM Find+Rename will normally run with standard user rights independently of having
logged on to your computer with a standard user account or with an administrator account.

These standard access rights are quite sufficient for HM Find+Rename to work on all your own
files. Usually you save your own files in your Personal Folder and its subfolders.

However, if you want HM Find+Rename to modify properties of files which require administrative
access rights (e.g. files in folder 'C:\Program Files'), HM Find+Rename will display the error
message "access denied" during the rename or change action, because the standard access
rights are not sufficient for it.

HM Find+Rename with administrative access rights (hot recommended)

If needed, you can run HM Find+Rename with administrative user rights. Log on to your
computer with an administrator account. Right click HM Find+Rename's shortcut in the program
group or on the Windows Desktop and then select the context menu command 'Run as
administrator'.

This approach is explicitly not recommended. Don't modify files in the Windows folder or in folders
protected by Windows. This may compromise the stability of your system.
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Restrictions of the Shareware Version Vers. 11 Dz

The rename and change functions of the unregistered version of HM Find+Rename are limited to
maximal 10 modifications per session.

Besides, if you want to test more modifications, you can do that with the program's preview
mode. In preview mode the results of executed file modifications are displayed in the file list of
HM Find+Rename but the file modifications are not really done in the file system.

The unregistered version allows you to measure the savings of time by using HM Find+Rename,
for example, to rename a larger number of files with similar filenames compared to renaming the
files by editing a new filename for every single file.

How to register the Shareware version see Order Information.
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Technical Support ol i o gz

Registered and licensed users will get technical support directly from the Author of HM
Find+Rename:

Dipl.-Ing. Martin Haller
Software-Engineering & EDV-Beratung
Langkampfner Strasse 19
6330 Kufstein / Austria
support@hmse.biz.tm
http://hmse.biz.tm

How to register the shareware version see Order Information.

To report suggestions, modification requests and errors fill in the feedback form and send it to the
above email address. Thank you.
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Overview

e Installation

- Installation
e Maintenance Installation

- Repair Installation

- Installation of Additional Components

- Uninstallation of Additional Components
e Uninstallation

- Uninstallation

o Manual Uninstallation
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Installation Vers.1.1 Q

To install HM Find+Rename you should follow these steps:

1. Download the self-extracting installation package (exe file) for the desired language to a
temporary folder of your choice.

2. If you are using Windows NT/2000/XP or a later version of Windows make sure you are logged
in as user with administrative privileges.

3. Run the self-extracting HM Find+Rename installation package (exe file) and follow the
installation instructions displayed.

Note: If you have a previous version of HM Find+Rename installed on your computer, you need not uninstall the
previous version before. The setup program detects an existing installation and performs an update installation itself.

4. Next, read carefully the file readme.htm. It may contain further installation instructions.
Moreover, you will find the requirements for running the current program version in it.
Readme.htm contains a complete list of all files and folders installed on your computer by the
setup.

The setup program copies all required files of HM Find+Rename onto your computer and creates
the program symbols and shortcuts for all user accounts.

Notes:

e The installation package of HM Find+Rename exists in several languages. However, on a
computer with multiple Windows user accounts you can install only one language common to
all user accounts.

At the Product Homepage of the application you may find additional installation packages with
other languages for downloading.

¢ How to register the Shareware version see Order Information.

HM Find+Rename USER MANUAL Page 13 of 88



- - HM Find+Rename |2,
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Repair Installation

The installation program of HM Find+Rename provides a simple repair feature. If you have
erroneously deleted files, program symbols or shortcuts of HM Find+Rename you can reinstall
the missing parts as follows:

1. Under Windows NT/2000/XP and all later versions of Windows log in as user with
administrative privileges.
2. Run the self-extracting installation package (exe file) of HM Find+Rename.

3. The installation program self-recognizes that it is a maintenance installation and doesn't let
you enter any more certain installation options (installation path, program group).

4. On the wizard form 'Select Components' the components already installed are pre-selected.
Leave the selection unchanged and click Next to finish the installation.

Installation of Additional Components

Normally, on main installation of HM Find+Rename you install right from the start all optional
components needed. If not, it may happen that you have to additionally install an optional
component.

To install additionally an optional HM Find+Rename component follow these steps:

1. Perform a repair installation as described above in chapter 'Repair installation’.

2. On the wizard form 'Select Components' choose the installation type ‘Custom installation
and select additionally those components you want to install. Leave the check state of all other
components unchanged. Then follow the installation instructions displayed to finish the
installation.

]

Note:
This way you can separately install additional components, but you can't separately uninstall
components already installed.

Uninstallation of Additional Components

The installation program of HM Find+Rename can't uninstall optional components separately but
only together with the HM Find+Rename application.
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Uninstallation

To uninstall HM Find+Rename you should follow these steps:

1. Under Windows NT/2000/XP and all later versions of Windows log in as user with
administrative privileges.

2. Open Windows Control Panel and then the icon Programs and Features (aka Software in earlier
Windows versions).

3. In the list of Installed Programs select the item HM Find+Rename and click the button
Uninstall (aka button Remove in earlier Windows versions).

Assumed that uninstallation with Windows Control Panel is impossible, you can launch the
uninstall program

C:\Program Files\HM Find+Rename\Unins000.exe

straight from the Windows Explorer by double clicking.

Manual Uninstallation

A manual uninstallation is not recommended. Perform a manual uninstallation
only if the uninstall methods described above are impossible or have failed.
Incorrect modifications of the Windows system registry may cause your system
unstable.

To uninstall HM Find+Rename manually you should follow these steps:
1. If you are using Windows NT/2000/XP or a later version of Windows log in as user with
administrative privileges.

2. Delete the program group of HM Find+Rename from the Windows Start menu as well as the
shortcut on the Windows desktop (if existing).

3. Delete all files from the home directory of HM Find+Rename, usually the folder
C:\Program Files\HM Find+Rename

4. In the Windows registry delete the following items:

HKEY_LOCAL_MACHINE\Software\Dipl.-Ing. Martin Haller, Software-Engineering & EDV-Beratung\HM Find+Rename
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstall\HM Find+Rename_is1

Then perform the following steps once as administrator and once under each additional user
account HM Find+Rename was used:

1. Log in under this user account.

2. In the Windows registry delete the following key:
HKEY_CURRENT_USER\Software\Dipl.-Ing. Martin Haller, Software-Engineering & EDV-Beratung\HM Find+Rename
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Step-by-Step Instruction ol i o Q

Find and rename files
To find and rename one or more files in program view Find/Rename follow these steps:

Step 1: Specify the Search Folder for Searching
Step 2: Specify the Search Options

Step 3: Perform the Find Action

Step 4a: Specify the Replace Options

Step 5a: Perform the Rename Action

Find files and change their file properties

To find and change the file properties of one or more files in program view Dates/Attributes
follow these steps:

Step 1: Specify the Search Folder for Searching

Step 2: Specify the Search Options

Step 3: Perform the Find Action

Step 4b: Specify the Change Options

Step 5b: Perform the Change Action
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Step 1: Specify the Search Folder for HM Find+Rename Bﬁ.
Searching Vers.1.1 ,mé

To specify the search folder for searching, there are three choices:

¢ Enter the fully qualified path of the search folder into the input field 'Folder' (e.g. c:\windows),
or
e click the button E] beside the input field 'Folder' and open the dialog window 'Find Folder' to

choose the desired search folder. After closing the dialog window with OK the search folder
selected will be displayed in the input field 'Folder'.

¢ Or, open the dropdown list (shortcut 'Alt+|") of the input field 'Folder' and select one of the
pathes previously entered.

Step 2: Specify the search options
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After you have entered the search folder you can define following search options to configure the
Find action:

¢ Include subfolders
e Search pattern for filenames
e Regular expression

Step 3: Perform the Find action
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Step 3: Perform the Find Action ol i o Q

After you have entered the search folder and the desired search options you can start the Find
action as follows:

e Mouse: Click the 'Find' button, or

e Keys: 'Alt+F' or 'F5' or, if the input focus is not in the file list just press 'Return’ or 'Enter’.
During the Find action the folder currently searched will be shown in the status bar and the files
found will be added to the file list. At the end of the Find action the number of the files found will
be shown in the status bar.
A running Find action can be cancelled at any time.
Notes:

e For security reasons folders which are marked as system folders are not searched by a Find action. System folders
contain files you should better not modify. But caution, not all Windows folder are system folders.

e Furthermore, a Find action doesn't find files which are marked as temporary because that files are usually locked by
another application and therefore cann't be modified anyway.

Step 4a: Specify the replace options or
Step 4b: Specify the change options
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Before or after the Find action you can specify the following replace options to configure the
Rename action:

Restrictive search pattern for filenames

Replace pattern for filenames
Preview
Whole List

Step 5a: Perform the Rename action
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Step 5a: Perform the Rename Action ol i o Q

After you have entered the replace options you have two choices for renaming files. You can
rename either a single file or all files matching the search pattern.

To rename a single file matching the search pattern:

1. Select the file in the file list and

2. Mouse: click the 'Rename' button, or
Keys: "Al1t+R'

To rename all files matching the search pattern:

1. Mouse: click the 'Rename Al1l' button, or
Keys: 'Alt+A’

If the replace option 'Whole List' is selected, the 'Rename All' action always starts at the first line
of the file list, otherwise it starts with the currently selected file in the file list. The 'Rename All'
action always stops at the end of the file list.

During the 'Rename All' action the new filenames are displayed in the file list immediately. At the
end of the 'Rename All' action the count of files renamed will be shown in a dialog box.

A running 'Rename All' action can be cancelled at any time.

When using regular expressions please note the remarks on entering the search pattern.
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Before or after the Find action you can specify the following change options to configure the
Change action:

Restrictive search pattern for filenames

New file properties
Preview
Whole List

Step 5b: Perform the Change action
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Step 5b: Perform the Change Action ol i o Q

After you have entered the change options you have two choices for changing the file properties.
You can change the file properties either of a single file or of all files matching the search pattern.

To change a single file matching the search pattern:

1. Select the file in the file list and

2. Mouse: click the 'change' button, or
Keys: 'Al1t+G’'

To change all files matching the search pattern:

1. Mouse: click the 'change Al1' button, or
Keys: 'Alt+A’

If the change option 'Whole List' is selected, the 'Change All' action always starts at the first line of
the file list, otherwise it starts with the currently selected file in the file list. The 'Change All' action
always stops at the end of the file list.

During the 'Change All' action the new file properties are displayed in the file list immediately. At
the end of the 'Change All' action the count of files changed will be shown in a dialog box.

A running 'Change All' action can be cancelled at any time.

When using regular expressions please note the remarks on entering the search pattern.
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Using HM Find+Rename ol i o B?

These are the main functions provided by HM Find+Rename.

Entering Search Patterns
Selecting search Options
Entering Replace Patterns
Selecting Replace Options
Entering New File Times

Entering New File Attributes
Selecting Change Options

Cancel a Running Action

Undo of Rename and Change Actions
Sorting the File List Displayed
Editing a Filename in the File List
Other Commands in the File List
Search/Replace Patterns
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Entering Search Patterns ol i o B?

The search pattern describes the filenames to be add to the file list by a Find action.

You have two choices for entering a search pattern, either a filename with/without wildcards or a
regular expression.

To enter a filename with/without wildcards as search pattern:
1. Unselect the search option 'Regular expression’.

2. Enter the filename with/without wildcards into the input field 'search' or click the button
and select a search/replace pattern from the popup menu displayed.

To enter a regular expression as search pattern:
1. Select the search option 'Regular expression'.

2. Enter the regular expression into the input field 'search' or click the button and select a
search/replace pattern from the popup menu displayed.

Remarks on using a regular expression:

The Find action tries the regular expression against each filename once. If the filename (or part of
it) matches the regular expression, the file will be added to the file list.

The Rename action finds the first match of the regular expression in a filename starting at the
beginning of the filename of the file selected in the file list, and replaces the matching sub-string
corresponding to the replace pattern. Then, if the filename contains another match of the regular
expression, this filename still remains selected. The next Rename action starts again at the
beginning of this filename. However, if the filename contains no (more) matches of the regular
expression, the next filename matching the regular expression will be found and selected.

The Rename All action always replaces all matches of the regular expression within a filename
and, just after that, it searches for the next matching filename. So you can replace with a single
'Rename All' action, for example, all hyphens ("-") by underscores ("_") in all filenames of the file
list.

ATTENTION: Be careful in using the regular expression ".*" (matches not only any
characters but the empty string too!). Better use ".+" (matches any characters too but
one character at least). When using ".*" there may be some regular expressions finding
and renaming always the same filename again and again (endless).

Tip:

To prevent from this or to ensure that each filename will be renamed only once, you have to
formulate the regular expression adequately. For example, ALWAYS begin a regular expression
with the special character "A" (anchor to the beginning of the filename). If the regular expression
consists of some alternative branches (<regexp>|<regexp>]|...), each branch has to start with
AN (A<regexp>| N <regexp>|N...).
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There are the following search options to configure a Find action:

¢ Include subfolders
e Search pattern for filenames
e Regular expression

Search option: Include subfolders

If this search option is selected, all subfolders of the search folder will be included for searching,
and the subfolders of the subfolders too, recursively.

If this search option is NOT selected, only the search folder will be searched for files.

Search option: Search pattern for filenames

If you enter a search pattern into the input field 'search', only the filenames matching the search
pattern will be found in the folders.

If you enter NO search pattern into the input field 'search', one of the following search patterns
will be used depending on the search option 'Regular expression':

e If 'Regular expression' is NOT selected, the search pattern "*" is used.
e If 'Regular expression' is selected, the regular expression ".+" is used.

Search option: Regular expression

If this search option is selected, the search pattern in input field 'search' is assumed to be a
regular expression.

If this search option is NOT selected, the search pattern in input field 'search' is assumed to be a
filename with/without wildcards.
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The replace pattern describes the new filename for a found file. It may contain only characters
valid for a filename, plus the meta characters of the placeholders described below.
Entering replace patterns in the main window

Dependent on the value you have entered in the main window into the input field
'search' (filename with/without wildcards or a regular expression) you have to enter a
corresponding replace pattern into the input field 'rReplace’.

To enter a replace pattern:
¢ Enter the replace pattern into the input field 'Replace’ or

¢ click the button and select a replace pattern from the popup menu displayed.

The replace pattern is a filename without placeholders

In that case only the first file found in each folder will be renamed. For all other files found in the
folder you will get an error message because the filenames in each folder have to be unique.

The replace pattern is a filename with placeholders

In a replace pattern you can use the following placeholders:
Placeholder "&":

The placeholder s will be replaced by the characters matched by the entire search pattern. That is
always the entire filename for a wildcard search pattern. That can be either the entire filename or
just a part of it for a regular expression search pattern.

Examples with a wildcard search pattern:

Search pattern Replace pattern Matched file will be renamed to
*.txt A& Name.txt AName.txt

ol & - file Hello.txt Hello.txt - file
Examples with a regular expression as search pattern:

Search pattern Replace pattern Matched file will be renamed to
A[NT+$ &.txt Name Name.txt
ALK\, ¥ & - file Hello.txt Hello.txt - file

Hello-World.txt Hello$-$World.txt

-l $8$ Hello_Name.txt Hello$_$Name.txt

Placeholder "*";

This placeholder is allowed in a replace pattern if and only if the search pattern is a wildcard
search pattern.

You can use the placeholder * in a replace pattern one or more times. The * will be replaced by
the characters matching the corresponding * in the search pattern. What matters is the order of
the placeholder *. The first (left-most) * in the search pattern corresponds to the first * in the
replace pattern, and so on. If the replace pattern contains more placeholders * than the search
pattern, the more * are replaced by nothing (empty string).

Examples with a wildcard search pattern:
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Search pattern Replace pattern Matched file will be renamed to

*[?].* * X Name[1].htm Name.htm
*.txt ks Hello.txt Hello

& XY-* Hello.txt XY-Hello.txt
XY-* ks XY-Hello.txt  Hello.txt
*[*].* R Name[1].htm Name.1
*[?].* () Name[1].htm Name(htm).

Placeholder "Index":

A search pattern stores particular parts of a found filename to temporary character buffers which
you can refer to in the replace pattern with the placeholder "Index" to insert the content of the
referred buffer into the generated filename. There are a maximum of 9 character buffers.

For each wildcard * in a wildcard search pattern the characters of a found filename matched by
the * are stored to a character buffer. The character buffers are assigned to the wildcards * in a
left-to-right order which means, the first (left-most) wildcard * in the search pattern is assigned to
the first character buffer, the second wildcard * is assigned to the second character buffer, and so
on. Character buffers with no assignment remains empty.

In a regular expression search pattern you can specify with parentheses "( )" that the characters
matched by the subexpression within the parentheses should be stored in a temporary buffer. The
character buffers are assigned to the parentheses "( )" in a left-to-right order which means, the
first (left-most) parentheses "( )" in the search pattern is assigned to the first character buffer, the
second parentheses "( )" is assigned to the second character buffer, and so on. Character buffers
with no assignment remains empty. The open round bracket "(" of a parentheses "( )" expression
is the essential thing for these assignments. For example, in nested parentheses "( )" expressions
the outer expression is first.

In the replace pattern you can refer in any order to the content of those character buffers by an
index, starting with 1. The syntax of an index is like this:

\<index>
where <index> is a digit from 0 to 9.

The placeholder \1 will be replaced by the characters of the first character buffer. The placeholder
\2 will be replaced by the characters of the second character buffer, and so on. If you use an
index without having a corresponding reference in the search pattern, it will be replaced by
nothing (empty string).

Additionally, there is the placeholder \0 which is special. It will be replaced by the characters
matched by the entire search pattern (it corresponds to the placeholder s).

Examples with a wildcard search pattern:

Search pattern Replace pattern Matched file will be renamed to
Text-1.doc 1-Text.doc

*ok x \2-\1.* Text-1.gif 1-Text.gif
Text-2.doc 2-Text.doc

*[*].% \1.\3 Name[1].htm Name.htm
. ’ Name[12].doc Name.doc
Examples with a regular expression as search pattern:

Search pattern Replace pattern Matched file will be renamed to
A[NT+$ \0.txt Name Name.txt

Name[1].htm Name.htm

AENO-9THN(*) M2 Name[12].htm Name.htm

Placeholder "Counter":

You can specify a counter in the replace pattern as placeholder for a consecutive numbering of the
found files. The syntax of a counter is like this:

: (<start>;<inc>)

where <start> and <inc> are integer values. These integers control the counter during the
rename action.
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<start> defines the initial value of the counter. The first occurrence of a counter in the first
renamed file in a rename action will be replace by this initial value. The number of digits in
<start> defines the minimum count of characters to insert. If the current value of the counter has
less digits, preceeding 0 are inserted on the left-side. If <start> is omitted, the default initial
value for the counter is 0.

<inc> defines the increment of the counter (next counter value = old counter value + inc). If
<inc> is omitted, the default value for the increment is 1.

Note:

You can specify one or more counters in a replace pattern. However, all counters use internally the
same counter variable. Therefore the counters do not count independently from each other. The
first (left-most) counter in the replace pattern defines the start value and increment.

Examples with a wildcard search pattern:

Search pattern Replace pattern Matched file will be renamed to

Maria.gif Pic008.gif

* . gif Pic:(008).gif Monica.gif Pic009.gif
Martha.gif Pic010.gif
Maria.gif Picl.gif

*.gif Pic:(1;5).qif Monica.gif Pic6.gif
Martha.gif Pic11.gif
Maria.gif Pic0.gif

* . gif Pic:().gif Monica.gif Picl.gif
Martha.gif Pic2.gif
Maria.gif Pic0.gif

*.gif Pic:(;4).qif Monica.gif Pic4.gif
Martha.gif Pic8.gif
Maria.gif Maria.01

* . gif *.:(01) Monica.gif Monica.02
Martha.gif Martha.03
Maria.gif 010 Maria

*.gif :(010;10) * Monica.gif 020 Monica
Martha.gif 030 Martha
Maria.gif 1.6

*.gif 1(1;5).:(3) Monica.gif 11.16

Martha.gif 21.26
Examples with a regular expression as search pattern:

Search pattern Replace pattern Matched file will be renamed to

Maria01.gif Maria001.gif
A(¥[~0-9])[0-9]*\.gif \1:(001).gif Monica.gif Monica002.gif
Martha02.gif Martha003.gif

Placeholder "Formatting":

You can specify one or more upper/lower case formattings anywhere in the replace pattern. An
upper/lower case formatting changes the currently available replace text generated so far by the
replace pattern. The syntax of an upper/lower case formatting is like this:

: (<format>;<format width>)

where <format> is one of the following letters:

Letter Description

U Uppercase (conversion to upper case)

u Uppercase (conversion to upper case)
L Lowercase (conversion to lower case)
| Lowercase (conversion to lower case)

<format width> is an integer value controlling which and how many characters are converted. If
you enter a positive integer value, conversion starts at the beginning of the available replace text.
If you enter a negative integer value, conversion starts at the end of the available replace text. If
you enter 0 or if <format width> is omitted, the whole available replace text is converted.

Note that the position of the Formatting placeholder within the replace pattern is important. A
Formatting placeholder quite at the beginning of the replace pattern has no effect because at this

HM Find+Rename USER MANUAL Page 29 of 88



moment the replace text is empty. A Formatting placeholder quite at the end of the replace
pattern uses the whole replace text as basis for the conversion. A Formatting placeholder within
the replace pattern uses the currently available replace text as basis for the conversion, which is
the replace text generated so far by the part of the replace pattern left to the Formatting

placeholder.

Examples with a wildcard search pattern:

Search pattern
*.gif
* . gif
*.gif
* . gif

* . gif

Examples with a regular expression as search pattern:

Search pattern
AHN\gif$
~CF\-gif$
~CF\-gif$
AHN\.gif$

AC\.gif$

HM Find+Rename

Replace pattern Matched file will be renamed to

*.gif:(L) Maria.gif
*.gif:(U;1) maria.gif
*:(U).gif Maria.gif
*.gif:(U;-3) Maria.gif
Maria.Gif
*:(010).gif:(L):(U;1) MONica.gif
martha.gif

maria.gif
Maria.gif
MARIA.gif
Maria.GIF

Maria010.gif
Monica011.gif
Martha012.gif

Replace pattern Matched file will be renamed to

\1.gif: (L) Maria.gif
\1.gif:(U;1) maria.gif
\1:(V).qif Maria.gif
\1.gif:(U;-3) Maria.gif

Maria.Gif

\1:(010).gif:(L):(U;1) MONica.gif

martha.gif

maria.gif
Maria.gif
MARIA.gif
Maria.GIF

Maria010.gif
Monica011.gif
Martha012.gif
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There are the following replace options to configure a Rename or Rename All action:

¢ Restrictive search pattern for filenames
e Replace pattern for filenames

e Preview

Whole List

Replace option: Restrictive search pattern for filenames

A rename action renames only files displayed in the file list. However, if you do not want to
rename all files of the file list, you can enter a restrictive search pattern into the input field
'Search'. A restrictive search pattern describes only a subset of the files displayed in the file list.

An example:

You perform a Find action with the search pattern "x.txt". The file list will display all files found
with extension ".txt". But you would like to rename only those files of them, starting with an "A" in
the filename.

For that, you have to enter the restrictive search pattern "a*.txt" into the input field 'Search'
and the desired replace pattern into the input field 'rReplace', and start the rename action.

Another example:

You perform a Find action with the search pattern "a*.txt". The file list will display all files found,
starting with an "A" in the filename and with extension ".txt". There are further files in the search
folder, not matching the search pattern and not displayed in the file list. Hence, if you enter the
search pattern "*.*" into the input field 'search' and the desired replace pattern into the input
field 'rReplace', and start the rename action, all files displayed in the file list will be renamed.
Those files of the search folder which are not displayed in the file list but would match the new
search pattern "*.*" too, will not be renamed because they are not contained in the file list.

Replace option: Replace pattern for filenames

To rename files you have to enter a replace pattern into the input field 'Replace’'. The replace
pattern is used to determine the new filename.

If you have not entered a replace pattern, the rename buttons are inactive.

Replace option: Preview

If this replace option is selected, the files found will be renamed only in the file list but not in the
file system. So, the files will actually not be renamed. This option is useful for testing the entered
search and replace patterns.

If this replace option is NOT selected, the files found will be renamed both in the file list and in the
file system.

Replace option: Whole List

If this replace option is selected, the 'Rename A11' action always starts at the beginning of the
displayed file list. Anyway, the 'Rename A11' action always ends at the end of the file list.

If this replace option is NOT selected, the 'Rename Al1' action starts with the currently selected
filename in the displayed file list. This option is usefull, for example, if a previous 'Rename Al1l'
action was aborted due to an error and you want to resume the action with the next filename.
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If not visible, switch to the program view Dates/Attributes.

Selection of the file times to change

In the column 'Change' of the input field group 'New File Times' check those file times you
want to change. The corresponding date/time input fields beside will be activated. The unchecked
file times will remain unchanged during subsequent change actions.

Entering a new file time
You always have to enter all related date/time input fields of a file time.
In each input field under the column 'New Date' you have the following alternative ways:

e Keys: Just enter the new value on the keyboard or count the currently selected value up or
down with the arrow keys '+' and ', '. Using the arrow keys '-' and '—' you can jump to the
next or previous value within the input field.

e Mouse: Clicking the drop-down list button at the right side of the input field opens a calender
control element instead of the drop-down list in which you can easily choose a new date with
few mouse clicks.

In each input field under the column 'New Time' you have the following alternative ways:

e Keys: Just enter the new value on the keyboard or count the currently selected value up or
down with the arrow keys '+' and ', '. Using the arrow keys '-' and '<' you can jump to the
next or previous value within the input field.

e Mouse: Count the currently selected value up or down by clicking the spin button arrows at
the right side of the input field.
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If not visible, switch to the program view Dates/Attributes.

Selection of the file attributes to change

In the column 'Change' of the input field group 'New File Attributes' check those file
attributes you want to change. The corresponding checkboxes beside will be activated. The
unchecked file attributes will remain unchanged during subsequent change actions.

Entering a new file attribute

If you want to set a file attribute (e.g. Archive), CHECK the corresponding checkbox in the column
'New Value'.

If you want to unset/clear a file attribute (e.g. Archive), UNCHECK the corresponding checkbox in
the column 'New value'.

You can change the state of a checkbox as follows (the checkbox must have the input focus):

e Keys: press the Spacebar.
e Mouse: click the checkbox.
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There are the following change options to configure a Change or Change All action:

¢ Restrictive search pattern for filenames
* New file properties

e Preview

e Whole List

Change option: Restrictive search pattern for filenames

A change action changes only files displayed in the file list. However, if you do not want to change
all files of the file list, you can enter a restrictive search pattern into the input field 'Search'. A
restrictive search pattern describes only a subset of the files displayed in the file list.

You will find examples for explanation of this option in the corresponding chapter Replace option.

Change option: New file properties

To be able to change the properties of files you have to enter a new file time or a new file
attribute at least.

If you have not entered a new file property, the change buttons are inactive.

Change option: Preview

If this change option is selected, the files found will be changed only in the file list but not in the
file system. So, the files will actually not be changed. This option is useful for testing the entered
search patterns and new file properties.

If this change option is NOT selected, the files found will be changed both in the file list and in the
file system.

Change option: Whole List

If this change option is selected, the 'change A11' action always starts at the beginning of the
displayed file list. Anyway, the 'change A11' action always ends at the end of the file list.

If this change option is NOT selected, the 'change Al11' action starts with the currently selected
filename in the displayed file list. This option is usefull, for example, if a previous 'Change All'
action was aborted due to an error and you want to resume the action with the next file.
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To cancel a running Find, Rename or Change action:

e Mouse: click the 'stop' button, or
e Keys: press Esc or just Return or Enter.
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With the 'Undo' command you can undo all rename and change actions since the last find
action. To enable this command for the file list, set the input focus into the file list, for example,
by clicking it once.

You cannot undo rename or change actions previous to the last find action. In that case you have
to rename the renamed files with new rename actions back to their old filenames and you have to
change the changed files with new change actions back to their old file properties, if possible.
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You can sort the file list by any column, ascending or descending. You can reverse the order
(ascending, descending) by sorting the file list twice by the same column.

To sort the file list:
e Click the column header of the column you want to be the sort criteria for the file list.

Tip:
To sort the file list by a main sort criteria and a sub sort criteria:

1. Sort the file list by the sub sort criteria (e.g. hame) as many times as needed for the order
(ascending, descending) you want.

2. Then sort the file list by the main sort criteria (e.g. folder) as many times as needed for the
order (ascending, descending) you want.

After that the file list is sorted by main/sub sort criteria (e.g. folder / name).
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To edit a filename straight in the file list:

1. Select the filename in the file list.
2. Start editing of the filename by:

Mouse: click the selected filename once, or
Keys: press function key r2.

Thereupon the filename will be framed with a thin border and you can edit the text of the
filename.

3. Enter the new filename.
4. Finish editing of the filename by:

Mouse: click somewhere in the window outside the border of the filename, or
Keys: just press Return or Enter.
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Beside the commands Sorting the file list and Editing a filename there are further commands
available in the file list:

¢ Double-click a filename:
Executes the default command defined for the file type (usually: open).

e 'Alt+Enter' with a selected filename:
Displays the properties window of the selected file.

e 'Del' with a selected filename:
Deletes the selected file.

¢ Right-click a filename or
'Shift+F10' with a selected filename:
Displays the context menu defined for the file type.

e 'Ctrl+C' or 'Ctrl+X' with a selected filename:
Copy or cut the selected file to the Windows clipboard.

¢ Drag & Drop with a selected filename:
For example, if you drag the selected file to a Windows Explorer window and drop it over a
folder in this window, the file is copied or moved to the folder (depending on the fact if you
press the 'Ctrl' key during dropping or not).

¢ Right-click somewhere in the other area of the file list (not a filename):
Displays the menu 'Edit' (command 'Undo").

Notes

e The above commands are available for multiple selected files in the file list too.

e If you have renamed some files of the file list in preview mode the commands above are not
available for those renamed files because in the file system those files will not be found with
the new name.
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Overview

e Pattern Types

o Wildcards

o Regular Expressions
e Managing Search/Replace Patterns
e Selecting a Search/Replace Pattern
e Selecting a Replace Pattern
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The pattern type specifies the kind of a search/replace pattern.
There are two kinds of search/replace patterns:

e Patterns with wildcards and
e Patterns with regular expressions.

Patterns with wildcards

A search pattern with wildcards describes a group of similar filenames with the help of simple
wildcards.

A replace pattern suitable for it describes in the same manner the new filenames for the files
found with a search pattern with wildcards. For details on the placeholders for such a replace
pattern, see chapter Entering Replace Patterns.

Patterns with regular expressions

A search pattern with regular expressions describes a group of similar filenames with the help
of regular expressions.

A replace pattern suitable for it describes in a similar manner the new filenames for the files
found with a search pattern with regular expressions. For details on the placeholders for such a
replace pattern, see chapter Entering Replace Patterns.
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Wildcards are special characters which are placeholders for none, one or more characters in the
filename.

To specify a search pattern for a filename you can use the following wildcards:

* ... asterix is a placeholder for any count of any characters.
2 ... the question mark is a placeholder for any single character.

Examples:
Filename with wildcards Description
*.txt All filenames ending with ".txt"
*.? All filenames ending with a dot followed by any single character
& All filenames
ab?? All filenames with a length of 4 characters and beginning with "ab"
ab*cd All filenames beginning with "ab" and ending with "cd"
*x*y* All filenames containing at least one "x" and one "y"
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The Brief Tutorial contains a short description of the special characters for regular expressions
and their meaning.

In the Detailed Description you will find details about syntax and semantic of regular expressions,
information about ambiguity of regular expressions and other implementation notes.

The chapter Character Classes lists examples of frequently needed regular expressions.

This implementation of regular expressions has been derived from work by Henry Spencer which is
redistributable and useable in source and binary forms, with or without modification, provided that
the Original Copyright Information are enclosed in the documentation.

This implementation of regular expressions is a plurally altered and extended software
compared with the original version of Henry Spencer.

HM Find+Rename USER MANUAL Page 43 of 88



d A HM Find+Rename |2,
Brief Tutorial Vers.1.1 Qz

Regular expressions are text patterns that are used for string matching. Regular expressions
are strings that contains a mix of plain text and special characters to indicate what kind of
matching to do.

The table below describes briefly the special characters:

Character Description

Anchors the match to the beginning of a line. For example, the expression "~A" will match the character "A"
A only at the beginning of the line.

The caret "~" is significant only at the start of an expression.

Anchors the match to the end of a line. For example, the expression "txt$" will match the sub-string "txt"
$ only if it is at the end of a line.

The dollar sign "$" is significant only at the end of an expression.

Matches the expression before or after the "|". Mostly used within a group (sub-expression). For example,
"(abc)|(def) ghi" matches "abc ghi" and "def ghi".

The dot matches any one character.

Set of Characters. Matches any one of the characters within the []. For example, "[abc]" matches either "a"
[1 or "b" or "c". To specify a range of characters, list the starting and ending character separated by a dash, as
in "[a-z]", which matches any one lowercase letter.

[~] Characters Not in Set. Matches any character not in the set of characters following the caret "~", for
example "[~0-9]" matches any one character which is not a digit.

The parenthesis groups the characters within the parenthesis to a sub-expression and therefore affects the

order of pattern evaluation. For example "(abc|d)" matches "abc" or "d", where as "ab(c|d)" matches "abc"

or "abd".

The parenthesis also serves as a tagged expression which tags the text matched by the enclosed expression.

0 A tagged expression is something like a temporary memory. This memory can then be used when you want
to replace the found expression with a new expression. The replace expression can specify "\N" where N is a
number from 1 to 9 which inserts the text matched by the Nth tagged expression. The "\0" indicates a
tagged expression representing the entire sub-string that was matched. Note that although the tagged
expression 0 is always defined, the tagged expression 1, 2 etc. are only defined if the regular expression
used in the search had enough sets of parenthesis, otherwise they insert an empty string.

Matches the character or expression between "\<" and "\>" only, if it starts and ends with a word boundary.
A word boundary is either the null string or a character which is neither an alphanumeric character nor an
underscore "_". For example, the regular expression "\<old\>" matches "old" in "I am old." but not in "It is
cold.".

\<\>

Escape character. Matches the character following the backslash "\". This allows you to find the special
\ characters used in the regular expression notation. For example, the expression "\." matches the dot
character ".".

The asterix "*" indicates that the character or expression to the left of the asterix in the expression should
& match 0 or more times, matching as many characters as possible. For example, "a*" matches a sequence of

[ ]

0 or more "a".

The plus "+" indicates that the character or expression to the left of the plus in the expression should match

4P 1 or more times, matching as many characters as possible. For example, "a+" matches a sequence of 1 or
more "a".
? The question mark "?" matches the character or expression to its left O or 1 times.

Bounded repeater. The braces "{}" indicates that the character or expression to the left of the "{n,m}" in
the expression should match from n to m times, matching as many characters as possible.

The integers n and m must lie between 0 and 255 inclusive, and n may not exceed m. The upper bound m
{n,m} may be omitted which means "more times". For example, "a{0,}" is aquivalent to "a*", "a{1,}" is aquivalent

to "a+" and "a{3,}" matches a sequence of 3 or more "a".

Braces containing one integer and no comma "{n}" means "exactly n times". For example, "a{0}" is
aquivalent to an empty string, "a{1}" is aquivalent to "a" and "a{3}" is aquivalent to "aaa".

Note:

All other characters (the non-special characters) in a regular expression matches exactly
themselves. As default the character match is case-insensitive. For example, the regular
expression "ab" matches "ab" and "Ab" and "AB" and "aB"; or the regular expression "[a-z]"
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matches any lower case character as well as any uppercase character. Optional a case-sensitive

character match is possible.

The special characters asterix "*", plus "+" and bounded repeaters "{n,m}" always match as
many characters as possible (maximum). The first (left-most) sub-expression has priority. An

example:

The regular expression ".*[0-9]+.*" matches the text "abc01234def" like this: the first left-most
sub-expression ".*" matches the sub-string "abc0123" (as many characters as possible), the
second sub-expression "[0-9]+" matches the character "4" (at least one character) and the last
sub-expression ".*" matches the remaining sub-string "def" (as many characters as possible).

For detailed information on regular expressions see Detailed Description.

Examples:

Regular Expression Input String Match Results

a[~]b]c

a[~b]]lc

~a(bc+|b[eh])g|.h$

ab*

ab?

ab+

ab{2,}

ab{2,4}

a*?

$*

(a*)+

HM Find+Rename

xadcd
xa]cd

xa]cd
xay]cd

abh

abbbbbc

adc
no match

no match
ay]c

bh

a

ab
abbb

a
ab
ab

no match
ab
abbb

no match
no match
abbb

no match
no match
abbb
abbbb

error
error
error

error
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Syntax and Semantic
Ambiguity
Other Implementation Notes and Restrictions

Syntax and Semantic

A regular expression is one or more "branches", separated by "|". It matches anything that
matches one of the branches.

A branch is one or more "pieces", concatenated. It matches a match for the first, followed by a
match for the second, etc.

A piece is an "atom" possibly followed by "*", "+", "?", or a "bound". An atom followed by "*"
matches a sequence of 0 or more matches of the atom. An atom followed by "+" matches a
sequence of 1 or more matches of the atom. An atom followed by "?" matches a match of the
atom, or the null string.

A bound is "{" followed by an unsigned decimal integer, possibly followed by "," possibly followed
by another unsigned decimal integer, always followed by "}". The integers must lie between 0 and
255 inclusive, and if there are two of them, the first may not exceed the second. An atom followed
by a bound containing one integer n and no comma ("{n}") matches a sequence of exactly n
matches of the atom. An atom followed by a bound containing one integer n and a comma
("{n,}") matches a sequence of n or more matches of the atom. An atom followed by a bound
containing two integers n and m ("{n,m}") matches a sequence of n through m (inclusive)
matches of the atom.

An atom is a regular expression in parentheses "(...)" (matching a match for the regular
expression), an empty set of parentheses "()" (matching the null string), a range (see below), a
word boundary (see below), "." (matching any single character), "A" (matching the null string at
the beginning of a line), "$" (matching the null string at the end of a line), a "\" followed by one of
the characters "~.[$()|*+?{\" (matching that character taken as an ordinary character), a "\"
followed by any other character (matching that character taken as an ordinary character, as if the
"\" had not been present) or a single character with no other significance (matching that
character).

It is illegal to end a regular expression with "\".

A "{" followed by a character other than a digit is an ordinary character, not the beginning of a
bound.

A range is a sequence of characters enclosed in "[]". It normally matches any single character
from the sequence. If the sequence begins with "A", it matches any single character not from the
rest of the sequence. If two characters in the sequence are separated by "-", this is shorthand for
the full list of characters between them (inclusive) in the collating sequence (e.g. "[0-9]" in ASCII
matches any decimal digit). It is illegal for two ranges to share an endpoint, e.g. "a-c-e". Note,
which characters effectively are contained in a range depends on the based character set.

To include a literal "]" in the sequence, make it the first character (following a possible "~"). To
include a literal "-", make it the first or last character. All other special characters, including "\",
lose their special significance within a range.

A word boundary "\<" and "\>" match the null string at the beginning and end of a word
respectively. A word is defined as a sequence of word characters which is neither preceded nor
followed by word characters. A word character is an alphanumeric character (letter or digit) or an
underscore "_".

Ambiguity

If a regular expression could match two different parts of the input string, it will match the one
which begins earliest. If both begin in the same place but match different lengths, it matches the
longest. Sub-expressions also match the longest possible sub-strings, subject to the constraint
that the whole match be as long as possible, with sub-expressions starting earlier in the regular
expression taking priority over ones starting later.

In general, the possibilities in a list of branches are considered in left-to-right order, the
possibilities for "*", "+", "?", and "{n,m}" are considered longest-first, nested constructs are
considered from the outermost in, and concatenated constructs are considered leftmost-first. The
match that will be chosen is the one that uses the earliest possibility in the first choice that has to
be made. If there is more than one choice, the next will be made in the same manner (earliest
possibility) subject to the decision on the first choice. And so forth.
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For example, "(abja)b*c" could match "abc" in one of two ways. The first choice is between "ab"
and 'a'; since "ab" is earlier, and does lead to a successful overall match, it is chosen. Since the
"b" is already spoken for, the "b*" must match its last possibility -- the empty string -- since it
must respect the earlier choice.

In the particular case where the regular expression does not use "|" and does not apply "*", "+",
"?", or "{n,m}" to parenthesized subexpressions, the net effect is that the longest possible match
will be chosen. So "ab*", presented with "xabbbby", will match "abbbb". Note that if "ab*" is tried
against "xabyabbbz", it will match "ab" just after "x", due to the begins-earliest rule. (In effect,
the decision on where to start the match is the first choice to be made, hence subsequent choices
must respect it even if this leads them to less-preferred alternatives.)

More examples:

The regular expression "(wee|week)(knights|nights)" matches all ten characters of "weeknights",
the first parenthesized subexpression matches "wee" and the second matches "knights".

When the regular expression "(.*).*" is matched against "abc" the parenthesized subexpression
matches all three characters.

Other Implementation Notes and Restrictions
The maximum count of parentheses "( )" is 9.
A regular expression should not be longer than 255 characters.

If the option 'case-insensitive' is selected, this applies to all letters of the regular expression, to
the letters within a range too.
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The table below lists frequently needed regular expressions for several character classes:

Regular Expression Description / Character Class
[a-zA-Z0-9] Alphanumeric character
[a-zA-Z] Alphabetic character
[a-zA-Z]+ Alphabetic string
[0-9] Decimal digit
[0-9]+ Decimal number
[0-9a-fA-F] Hexadecimal digit
[a-zA-Z_$][a-zA-Z0-9_$1* Identifier

([0-9]1+\.[0-91*)|([0-9]*\.[0-9]+)|([0-9]+) Relational number
C"IA"TICIANTE) Quoted string
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Vers. 1.1

The Original Copyright Information of the work about regular expressions by Henry Spencer:

Copyright (c) 1986, 1993, 1995 by University of Toronto.
Written by Henry Spencer. Not derived from licensed software.

Permission is granted to anyone to use this software for any
purpose on any computer system, and to redistribute it in any way,
subject to the following restrictions:

1,

Note:

The author is not responsible for the consequences of use of
this software, no matter how awful, even if they arise from
defects in it.

The origin of this software must not be misrepresented, either
by explicit claim or by omission.

Altered versions must be plainly marked as such, and must not
be misrepresented (by explicit claim or omission) as being the

original software.

This notice must not be removed or altered.

The above copyright applies solely to the employed regular expression work of Henry Spencer. For
the enclosed software product as a whole the copyright and end user license agreement, you have
accepted by installation, are effective.
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You have two possibilities for managing the search/replace patterns:
e With the menu command 'View » Options' open the 'Options' dialog and then click the
'Search/Replace Patterns' tab.
In this tab you can insert, edit and delete search/replace patterns.
e Quick insertion of search/replace patterns:

In either of the input fields 'Search' or 'Replace' in the main window press the keyboard
shortcut ctrl+shift+Ins to open the 'Search/Replace Pattern' dialog in insertion mode. The
current values of the input fields 'search' and 'Replace' are picked up as default. Enter the
other dialog input fields and save the new search/replace pattern with ox.
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To select a search/replace pattern in the main window:

1. First determine the desired pattern type by checking (= pattern type Regular Expression) or
unchecking (= pattern type Wildcard) the search option 'Regular Expression'.

2. Next, click the button beside the input field 'search' and select a search/replace pattern
from the popup menu displayed.

Notes:

e The popup menu displays only search/replace patterns matching the selected pattern type.

e The popup menu displays only search/replace patterns containing either a search pattern
alone or both a search and replace pattern. It does not display patterns containing a replace
pattern alone.

e To close the popup menu without selecting a pattern, click somewhere in the empty area of
the window outside of the popup menu or press one of the keys Esc or a1t.
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To select a replace pattern in the main window matching the search pattern already entered:
1. Leave the search option 'Regular Expression' unchanged in order to have the replace
pattern the same pattern type as the search pattern already entered.

If you have not yet checked or unchecked the search option 'Regular Expression’' suitable
for the search pattern already entered, specify now the desired pattern type by checking (=
pattern type Regular Expression) or unchecking (= pattern type Wildcard) this search option.

2. Next, click the button beside the input field 'rReplace’ and select a replace pattern from
the popup menu displayed.

Notes:

e The popup menu displays only replace patterns matching the selected pattern type.

e The popup menu displays only pure replace patterns that are those search/replace patterns
containing a replace pattern alone.

e To close the popup menu without selecting a pattern, click somewhere in the empty area of
the window outside of the popup menu or press one of the keys Esc or Alt.
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User Interface

Overview

¢ Main Window

o

o

o

o

o

o

o

'Find/Rename' View
'Dates/Attributes' View
Title Bar

= System Menu
Menu Bar
Toolbar
Status Bar
Scroll Bars

¢ 'Options' Dialog

o

'General' Options

- 'Search/Replace Pattern' Options

e 'Search/Replace Pattern' Dialog

¢ 'About' Dialog

e 'License Activation' Dialog
e Keyboard Shortcuts of HM Find+Rename
¢ Getting Help on HM HM Find+Rename

e Error codes of HM Find+Rename

HM Find+Rename
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The main window offers two views which can be toggled with the menu commands 'View »
Find/Rename' and 'View » Dates/Attributes'. In the 'Find/Rename' view you can search and
rename files. In the 'Dates/Attributes' view you can search files and change their file properties.

Directions for Use

The basic directions for use are the same in both views. First, you have to start a Find action to
find the files you want to modify. The Find action adds the files found to the program's file list.
Then you can modify the files in the file list (or a subset thereof) by a Rename or Change action
(according to the view). For more details on the several steps of this process, see Step-by-Step
Instruction.

The 'Options' dialog enables you to configure the program and adjust it to your requirements.

File List
The file list is located in the bottom area of the main window.

The file list columns indicate the file properties which are of relevance to the current view. Clicking
a column header sorts the file list by this column.

After a Find action the file list shows the files found. During a Rename All or Change All action the
file list shows ongoing the modified file properties.

With the 'Undo' command of the file list you can undo all rename and change operations since the
last Find action.

You may select one or more files in the file list and perform file-specific commands just like in
Windows Explorer. See chapter "Other Commands in the File List".

Dialog Elements

For a detailed description of the program-specific dialog elements in the main window, see the
Help on the particular view:

} 'Find/Rename’' view
b 'Dates/Attributes' view

The other dialog elements and areas of the main window are similar to any other Microsoft
Windows standard application. The main window has a Title bar (including a System menu), a
Menu bar, a Toolbar and a Status bar.

Miscellaneous

The 'About' dialog displays the program version and the copyright, license and support information
as well. Furthermore this dialog window has a button to open the 'License Activation' dialog in
which you can enter your license information to activate the unregistered shareware version.
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In this view of the main window you can search and rename files.
Dialog Elements

Folder Fully qualified path and name of the folder you want to be searched for files by the next
Find action. Required input.
For detailed information on the input possibilities of this input field, see chapter "Specify
the Search Folder for Searching".

Button ...’ See chapter "Specify the Search Folder for Searching".
Include Subfolders See chapter "Search Options".
Search For a Find action enter a search pattern describing the filenames to be added to the file

list. If empty, all files of the search folder will be found.

For a Rename action enter a search pattern matching those filenames in the file list
which should be renamed. Mostly that is the same search pattern as in the previous
Find action. However, it could be a restrictive search pattern matching only a subset of
the files in the file list, or it is a modified search pattern which, for example, matches all
files but additionally buffers parts of the filename, etc. If empty, none files of the file list
are matching.

The type of the search pattern is determined by the check box 'Regular Expression'.

For detailed information on the input possibilities of this input field, see chapter
"Entering Search Patterns".

Button '>' Displays a popup menu with stored search/replace patterns you can select and insert
(beside 'Search') into the main window.

For more information see chapter "Selecting a Search/Replace Pattern".
Regular Expression See chapter "Search Options".

Replace For a Find action this input is not required and may be empty.

For a Rename action enter a replace pattern describing the new filename for a found
file. The replace pattern has to be suitable to the pattern type of the search pattern you
have entered into the input field 'Search'.

For detailed information on the input possibilities of this input field, see chapter
"Entering Replace Patterns".

Button '>' Displays a popup menu with stored replace patterns you can select and insert into the
(beside 'Replace') main window.

For more information see chapter "Selecting a Replace Pattern".

Preview This option controls rename actions. For more information see chapter "Replace
Options".

Whole List This option controls rename actions. For more information see chapter "Replace
Options".

Buttons

Use button 'Find' to start a find action. For detailed information see chapter "Perform the Find
Action".

Use button 'Rename’' to perform a single rename action with the file currently selected in the
file list if it matches the search pattern. Otherwise, the next matching file is searched in the file
list. For detailed information see chapter "Perform the Rename Action".

Use button 'Rename All' to perform a rename action with all files in the file list matching the
search pattern. For detailed information see chapter "Perform the Rename Action".

Use button 'Stop' to cancel a running find or rename action. For further information see chapter
"Cancel a Running Action".
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In this view of the main window you can search files and change their file properties.
Dialog Elements

Folder Fully qualified path and name of the folder you want to be searched for files by the next
Find action. Required input.

For detailed information on the input possibilities of this input field, see chapter "Specify
the Search Folder for Searching".

Button ...’ See chapter "Specify the Search Folder for Searching".
Include Subfolders See chapter "Search Options".
Search For a Find action enter a search pattern describing the filenames to be added to the file

list. If empty, all files of the search folder will be found.

For a Change action enter a search pattern matching those filenames in the file list of
which the file properties should be changed. Mostly that is the same search pattern as in
the previous Find action. However, it could be a restrictive search pattern matching only
a subset of the files in the file list. If empty, none files of the file list are matching.

The type of the search pattern is determined by the check box 'Regular Expression'.

For detailed information on the input possibilities of this input field, see chapter
"Entering Search Patterns".

Button '>' Displays a popup menu with stored search/replace patterns you can select and insert
(beside 'Search') into the main window.

For more information see chapter "Selecting a Search/Replace Pattern".

Regular Expression See chapter "Search Options".

Preview This option controls change actions. For more information see chapter "Change
Options".

Whole List This option controls change actions. For more information see chapter "Change
Options".

New File Times For a Find action the inputs of this group box are not used.

For a Change action check those file times beneath 'Change' which you want to modify.
Then enter the new date and time.

For detailed information on the input possibilities of this group box, see chapter
"Entering New File Times".

New File Attributes For a Find action the inputs of this group box are not used.

For a Change action check those file attributes beneath 'Change' which you want to
modify. Then, beneath 'New Value', specify the new state of each file attribute
concerned.

For detailed information on the input possibilities of this group box, see chapter
"Entering New File Attributes".

Buttons

Use button 'Find' to start a find action. For detailed information see chapter "Perform the Find
Action".

Use button 'Change’ to perform a single change action with the file currently selected in the file
list if it matches the search pattern. Otherwise, the next matching file is searched in the file list.
For detailed information see chapter "Perform the Change Action".

Use button 'Change All' to perform a change action with all files in the file list matching the
search pattern. For detailed information see chapter "Perform the Change Action".

Use button 'Stop' to cancel a running find or change action. For further information see chapter
"Cancel a Running Action".
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The title bar is located along the top of a window.

& HM Find+Rename

The title bar of the main window shows the name of the application, whereas the title bar of dialog
windows shows the name of the dialog function.

Drag the title bar to move the window. Double-click the title bar to maximize or restore the
window.

Note: You can also move dialog windows by dragging their title bar.

The title bar of the main window contains the following dialog elements:

e Application Control menu box (System menu)
e Name of the application

e Document name (optional)

e Minimize button

e Maximize button or Restore button

¢ Close button

Note: The buttons of the title bar correspond with the commands of the same name in the System menu.

The title bar of a dialog window contains the following dialog elements:

¢ Name of the window
e Context help button
e Close button
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The System menu (Control menu) of the main window offers the following commands:

Restore Restores normal size and position of the window.
Move Moves the window (with arrow keys).
Size Changes the size of the window (with arrow keys).
Minimize Reduces the window to an icon.
Maximize Enlarges the window to full size.

Close Closes the window.

Shortcuts

Keys:  Alt + Spacebar
Mouse: Click on the top left edge in the title bar of the main window.

File* Edit Wie

I=l=
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The menu bar is displayed across the top of the application's main window, below the title bar:

File Edit Mjew Help

The menu bar provides mouse or keyboard access to the command menus of the application.

Command menus of the application
¢ 'File' menu
e 'Edit' menu
e 'View' menu
¢ 'Help' menu
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The 'File' Menu offers the following commands:

Exit Exits the application.

Envoking

Keys: Alt + F
Mouse: Click on "File" in the menu bar of the application.
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The 'Edit' menu offers the following commands:

Undo Reverse the last editing operation.
Cut Removes the selected data from the window and stores it on the clipboard.
Copy Copies the selected data from the window to the clipboard.
Paste Inserts the contents of the clipboard into the window.
Select All Selects all files of the file list or the entire text in input fields.

Invert Selection Inverts the selection of the file list.

Envoking

Keys: Alt + E
Mouse: Click on "Edit" in the menu bar of the application.

HM Find+Rename USER MANUAL Page 61 of 88



Wy ' HM Find+Rename |2,
View' Menu Vers.1.1 Dé

The 'View' menu offers the following commands:

Find/Rename Displays the program view for finding and renaming files.

Dates/Attributes Displays the program view for changing file properties.

Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the status bar.
Options Opens the 'Options' dialog window with the program settings.
Envoking

Keys: Alt + V
Mouse: Click on "View" in the menu bar of the application.
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The 'Help' Menu offers the following commands:

Help Topics Offers you an index to topics on which you can get help.
What's This Help Displays help for clicked on buttons, menus and window portions.

About Displays program information, version number and copyright.

Envoking

Keys: Alt+ H
Mouse: Click on "Help" in the menu bar of the application.
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The toolbar is displayed across the top of the application's main window, below the menu bar:

IEERE

) N2

The toolbar provides quick mouse access to frequently needed commands of the application.

To display or hide the toolbar, use the "Toolbar' command in the 'View' menu.
Tool Description

Displays the program view for finding and renaming files.

Displays the program view for changing file properties.

Removes the selected data from the window and stores it on the clipboard.

Copies the selected data to the clipboard.

Inserts the contents of the clipboard at the insertion point.

Reverse the last editing operation. Note: There are some actions you cannot undo.
Opens the 'Options' dialog window with the program settings.

Displays help for clicked on buttons, menus and window portions.
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The status bar is displayed at the bottom of the application's main window.

IF-:ur Help, press F1 CAP MUM SCRL I

To display or hide the status bar, use the 'Status Bar' command in the 'View' menu.

The left area of the status bar describes the actions of menu items as you use the ARROW KEYS to
navigate through menus. This area similarly shows messages that describe the actions of toolbar
buttons as you depress them, before releasing them.

Note: If after viewing the description of the toolbar button command you wish not to execute the command, then release
the mouse button while the pointer is off the toolbar button.

The right area of the status bar indicate which of the following keys are latched down:

Indicator Description

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
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Scroll bars are displayed at the right and bottom edges of a window. The scroll boxes inside the
scroll bars indicate your vertical and horizontal location in the window. You can use the mouse to
scroll to other parts of the window.
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Use the Options (preferences) to configure the program and adjust it to your requirements. Click
on the several tabs (option groups) and change the options you want.

The 'General' tab contains general options to configure the application.

The 'Search/Replace Pattern' tab serves for managing of user-defined search/replace patterns.

Buttons
Use button "OK' to save all your changes and close the dialog box.

Use button 'Cancel' to close the dialog box without saving the changes you have made since
opening the dialog box or the last saving of the options.

Use button 'Help' to display help on this dialog box.

Envoking

Open this dialog window with the menu command 'View » Options' in the Main Window of the
application.
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This tab of the 'Options' dialog contains general settings you can use to configure the applications
behaviour. Modifications of settings on this tab will take effect immediately after closing the dialog
box.

Dialog Elements

File List - This setting defines the maximum count of files displayed in the file list by a Find action. If there
Maximum Size are more files matching the search options the Find action stops after reaching this value.

The default setting 0 means, there is no maximum size for the file list.

On older Windows versions (Windows 95/98/Me) the default setting 0 or a

& very high value may cause system crashes or uncontrolable side-effects during
a Find action. If you experience such problems set the maximum size to 60000
and decrease it step-by-step till the problems are gone.

Rename All / This setting defines the error handling in the event the application cannot modify a single file
Change All - Error  during a Rename All/Change All action. The most frequent reason for this problem is that when
handling renaming a file another file with the same filename already exists in the folder.

First of all an error message with the path and name of the file will be displayed. Then, depending
on the error handling mode of this setting, execution will continue as follows:

e On ‘abort the Rename All/Change All action' (default setting):

The Rename All/Change All action will be cancelled. The filename concerned will be selected
in the file list. The files renamed/changed previously in the Rename All /Change All action
will still be renamed/changed.

e On ‘resume the Rename All/Change All action with the next file":

After confirmation of the error message the Rename All/Change All action will be resumed
with the next file. At the end of the Rename All/Change All action the count of files not
renamed/changed will be shown in a dialog box.

Tip: If you start once again a Find action with the same search options thereafter, you will
find exactly the files not renamed.

Auto-display of If this checkbox is checked a context help popup window (small tip window) is displayed

context help popup automatically if you position the mouse pointer over a dialog element.

windows (tips) If this checkbox is unchecked the context help popup windows are not displayed automatically.
But you can display them, if needed, using the shortcut Shift+F1. In chapter 'Getting Help' you
will find further ways to display context help or more detailed help.
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This tab of the 'Options' dialog serves for managing the user-defined search/replace patterns.
Modifications of the search/replace patterns on this tab will take effect immediately after closing
the 'Options' dialog.

There are two kinds of search/replace patterns, that are wildcard patterns (file names
with/without placeholders) and patterns with regular expressions. First choose the type of patterns
you want to manage. Then, from the list displayed, choose the search/replace pattern you want to
display or edit.

Dialog Elements

Pattern Type This radio button group serves for choosing the kind of search/replace patterns to
display.

Selecting the option 'Wildcard' will display the list with wildcard patterns.

Selecting the option 'Regular Expression’ will display the list with regular expression
patterns.

Pattern List This list box displays the search/replace patterns of the selected pattern type.
To display or edit the data of a search/replace pattern, select it in the list first.
If the input focus is in the list, there are the following input possibilities:
e The 'Ins' key triggers the 'Insert' button.
e The 'Del' key triggers the 'Delete' button with the selected search/replace pattern.
e The spacebar selects the current search/replace pattern.

e The '|' or '1' key moves the selection to the next or previous search/replace
pattern, respectively.

e Clicking a line of the list selects this search/replace pattern.
e Double-clicking a line of the list selects this search/replace pattern and triggers the

'Edit' button.
Buttons
Insert This button opens a dialog you can use to add a new search/replace pattern to the list
displayed.
Edit This button opens a dialog you can use to edit the data of the currently selected
search/replace pattern in the list displayed.
Delete This button removes the currently selected search/replace pattern in the list from the

list.

Note: The modifications made in the search/replace pattern lists by using the buttons above are
saved persistently only when closing the 'Options' dialog with OK.
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'Search/Replace Pattern' Dialog

HM Find+Rename
Vers. 1.1

Use this dialog to enter a new search/replace pattern or to edit the data of an existing
search/replace pattern.

A search/replace pattern is either a search pattern alone or a replace pattern alone or both a
search and replace pattern. Enter the input field values accordingly.

Dialog Elements

Pattern Type

Menu Item

Search Pattern

Replace Pattern

Status Bar Text

Caret Position
After Insertion
Is Situated In

Caret Position
After Insertion
Within The
Pattern

Buttons

Indicates the kind of the search/replace pattern (not editable). The pattern type is already defined
before opening the dialog window.

A short description of the search/replace pattern. Input is required.

The text entered into this field is the name of the search/replace pattern which on the one hand is
displayed in the popup menu for selecting a search/replace pattern and on the other hand is used
as key value for storing the search/replace pattern persistent. Therefore the menu item text has to
be unique which means there must not be another search/replace pattern with the same pattern
type and the same menu item text.

A search pattern describes the filenames to be add to the file list by a Find action.
Use here just such placeholders suitable for the pattern type displayed. May be empty.

A replace pattern describes the new filename for a found file.
Use here just such placeholders suitable for the pattern type displayed. May be empty.

Enter a description of the search/replace pattern as incisive as possible. May be empty.

The text entered into this input field will be shown in the status bar while displaying the popup
menu for selecting a search/replace pattern.

Defines the input field of the main window which will get the focus and caret after this
search/replace pattern was choosen in the popup menu and inserted in the main window.

Choose the option 'Search Pattern' if you have entered a search pattern alone or both a search and
replace pattern.

Choose the option 'Replace Pattern' if you have entered a replace pattern alone.

Defines the caret position within the input field (‘Search Pattern' or 'Replace Pattern') of the main
window after this search/replace pattern was choosen in the popup menu and inserted in the main
window.

Choose the desired option. If you choose the option ‘in the pattern after the x. char', additionally
enter the character position where the caret should be situated.

Use button 'OK' to close the dialog window and save all your changes to the search/replace

pattern list.

Use button '"Cancel’ to close the dialog box without saving your changes.

Use button '"Help' to display help on the dialog window.

Envoking

Open this dialog with one of the buttons 'Insert' or 'Edit' on the 'Search/Replace Patterns' tab in
the 'Options' dialog of the application.

Alternatively, pressing the shortcut 'ctri1+shift+Ins’' in the application's main window opens this
dialog too for inserting a new search/replace pattern.
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This dialog shows the exact version number of the program, as well as copyright, license and
support information.

Buttons
The button 'Close' closes the dialog window.

The button 'License' opens the 'License Activation' dialog where you can enter your license
information to activate the unregistered shareware version. Note: If the application need not to be
activated, this button does not exist.

Envoking

Open this dialog window with the menu command 'Help » About' in the main window of the
application. If there is no menu bar in the main window, use the system menu command 'System
menu » About' instead.
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In this dialog you can enter the license information you have got from the licenser to activate the
unregistered shareware version of the program. The activation of the program is done by
activating the entered license. Thereby the license will be verified. Note: You can repeat the
activation of a license as often as you want.

Dialog Elements

Enter all data exactly the same as specified in the license you have received from the licenser.
Note that the values are case-sensitive and pay attention to the difference between the
digit 0 (zero) and the uppercase letter O as well as the digit 1 and the uppercase letter
I. The license number does not contain lowercase letters.

Username: First name and last name of the user or other name. May not be empty.

Organization: Name of organization the user belongs to. May be empty for private persons.

Drive letter: Letter of the drive containing the bound volume, followed by a colon ':'.

Volume S/N: Serial number of the bound volume in hexadecimal. At least 4 characters.

Volume desc.: Name / description of your choice of the bound volume. It is used in messages and may

not be empty.

License number: The license number you have got from the licenser (also called activation code). At least
10 characters.

Buttons

The button 'Show Volumne S/N' shows the serial number of the currently mounted volume in
the drive entered in field 'Drive letter' and optionally take it to the input field 'Volume S/N'.

The button 'Check license' verifies the entered license information to be valid.
The button 'OK' activates the entered license (if it is valid) and closes the dialog window.
The button 'Cancel’ closes the dialog window without activating the entered license.

The button "Help' displays help on dialog window.

Envoking
Open this dialog window with the button 'License’ in the 'About’ dialog.

Due to Windows security restrictions administrative privileges are needed to activate a license. If
the following message is displayed when opening the dialog window, you are currently not
authorized to it and all input fields as well as the button 'OK' are disabled.

s

f . \ The program has currently no access rights to modify or activate a

@' license, To gain these rights you have to log on to Windows with an
administrator account and run the program with administrative
privileges (click 'Help' for more information).

oK || Hep

To gain the rights needed you have to log on to your Computer with an administrator account and
run the application with administrative privileges:

To find out which user account of your computer is an administrator account, open User
Accounts in Windows Control Panel. Then if needed, restart your computer and log on to
Windows with an administrator account.
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To start a program with administrative privileges in Windows Vista and later right click the
program's shortcut in the program group of the application and then select the context menu

command 'Run as administrator'. In previous Windows versions just click the program's
shortcut.

Note: Starting the application with administrative privileges is only necessary to activate a license
(see Activation). After it, you may restart the program as usual.
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Keyboard Shortcuts

HM Find+Rename
Vers. 1.1

Use keyboard shortcuts (also known as accelerator keys) to gain quick access to often used

commands or operations.

Common Shortcuts (in all windows)

Window control
Close the application
Close the active window
Help on the active window or the active dialog element
Edit field control
Direct jump to an edit field
Jump to the next edit field
Jump to the previous edit field
To the beginning of the edit field
To the end of the edit field
Undo the input
Combobox control
Open or close the item list
To the next/previous item in the open item list
Pick current item of the item list
Tab control
To the next tab
To the previous tab
Checkbox control
Check/uncheck the checkbox
Button control

Press the button

HM Find+Rename

USER MANUAL

Key(s)
Alt+F4 or Esc
Alt+F4 or Esc
F1 or Shift+F1

Key(s)
Alt+letter underlined
TAB
Shift+TAB
Pos1
End
Ctrl+Zz

Key(s)
Alt+| bzw. Alt+1
lort
Alt+| bzw. Alt+1

Key(s)
Ctrl+TAB
Shift+Ctrl+TAB

Key(s)
Spacebar

Key(s)

Spacebar
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HM Find+Rename offers you several ways to get help.

The What's This? help shows information on the current dialog element (edit field, combobox,
checkbox, push button, and so on) of a window. The help text is shown in a small popup window
near by the dialog element concerned. The popup window can be displayed automatically (tip
window), or manually if needed.

All other help types are displayed in an own help window which can be enlarged, reduced or
moved in any way.

The context help shows information on the active window and explains possible dependences of
the several dialog elements.

The help topics offer an overview and hierarchical outline with all help texts available.

The help index offers the possibility to filter and display the existing help topics using predefined
key words.

The full text search offers the possibility to search the existing help topics for any words.

Use the favorites to collect often used help topics to make them accessible quickly.
Envoking

Help Type Getting help

What's Keys: Shift+F1

This? Help Mouse: With the right mouse button click on the dialog element on which you need help. In the context
menu displayed after that select the menu item What's This?. Note: If the displayed context menu
does not contain a What's This? menu item (e.g. edit fields), right click the label of the dialog
element instead of the dialog element itself.

Depending on the current program configuration (see 'General' Options) you have additionally the
possibility to let display the What's This' help in an automatically shown tip window. For this, position the
mouse pointer for a moment over the dialog element you need help on.

Context Keys: F1

Help Mouse: Click the push button Help.
Help Keys: Alt+F1
Topics Mouse: n/a
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A file operation may fail due to several reasons. The table below contains a list with the most
frequent error codes which may occur on file operations. This list is an excerpt of the WIN32
SDK error codes:

Error

e Description

ERROR_FILE_NOT_FOUND

The file was not found (e.g. because it has been deleted by another program in the meantime).

ERROR_PATH_NOT_FOUND
The new filename is invalid (e.g. empty string).

ERROR_ACCESS_DENIED
5 You have no or too less access rights for the file to to perform a file operation with it (see also the notes on
Windows Vista and later).

ERROR_SHARING_VIOLATION

= The file is opened by another program/user.
33 ERROR_LOCKING_VIOLATION
The file is opened by another program/user.
123 ERROR_INVALID_NAME
The new filename contains an illegal character: \ / : *? " < > |
183 ERROR_ALREADY_EXISTS
There is already a file with this name in this folder.
206 ERROR_FILENAME_EXCED_RANGE
The new filename is too long (path and filename must not exceed 256 characters).
2250 ERROR_ALREADY_EXISTS

There is already a file with this name in this folder.
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Overview

e Copyright
e License Terms
e Copy Protection
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This Software product is NOT in the public domain. It is copyrighted by the Author. This Software
and accompanying documentation are protected by Austrian Copyright law and also by
international copyright and treaty provisions.
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On installation of the Software you have read and accepted the terms of the enclosed End User
License Agreement which applies to this Software product.

End User License Agreement

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THE
SOFTWARE. THIS AGREEMENT LICENSES THE ENCLOSED SOFTWARE

TO YOU AND CONTAINS WARRANTY AND LIABILITY DISCLAIMERS. BY
INSTALLING OR USING THE SOFTWARE, YOU ARE AGREEING TO
BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO

NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NEITHER
INSTALL NOR USE THE SOFTWARE.

1. Definitions.

(a) The term "Licenser" means "Dipl.-Ing. Martin Haller, Software-
Engineering & EDV-Beratung" and its suppliers.

(b) The term "Software" means the enclosed Licenser's software product
and the related documentation and all related updates.

(c) The term "registration code" in this document means the data
technical representation of a valid license according to point
5 of this agreement, whatever shape it has (activation code,
license number, license file or others).

The unregistered shareware version may be freely distributed, provided that:
e Such distribution includes only the original archive supplied by the Licenser. You may not
alter, delete or add any files in the distribution archive.

e Such distribution contains the same copyright and other proprietary notices pertaining to this
Software that appear in the Software.

e The distribution does neither include a registration code nor methods, programs or instructions
to get or create a registration code or in any other way upgrade the Software from its
unregistered status unlawfully.

¢ No money is charged to the person receiving the Software, beyond reasonable cost of
packaging and other overhead.
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As a simple copy protection mechanism the license of the registered version will be bound to the
serial number of a volume (disk, data medium) of your own. On ordering the license you tell us
the serial number of a volume of your choice and the drive letter of the drive connected to this
volume. At each startup the application checks the drive to contain this volume.

e How to choose a suitable volume for copy protection

e How to find out the serial humber of the volume of your choice

¢ What to do after reorganization of the drive letters of your computer

e What to do on damage of the bound volume or when buying a new computer

How to choose a suitable volume for copy protection

As bound volume (= volume for copy protection) you can choose one of the hard disks of your
computer or one of your 3.5" disks or CD-ROM's, DVD's, and so on.

However, on choosing your bound volume consider the following:

e Only /local volumes/drives are possible. Server volumes, network drives and RAM disks are not
allowed.

e Virtual volumes/drives which are logical partitions of a hard disk are allowed, but notice, they
have a virtual serial number which may change on repartitioning the hard disk whereby the
license would be invalid. Therefore, always choose the serial number of those partition which
corresponds to the physical hard disk.

e If you choose a fixed mounted volume/disk (e.g. the hard disk of your computer with drive
'C:") you will have the advantage of an easy startup of the application at any time without
having to insert the bound volume in a drive before. Moreover, hard disks have a higher
duration of life than a removable volume/disk (3.5" disk, CD-ROM, other removable disk,...).

Therefore we recommend to choose a fixed mounted volume/disk (the hard disk of your
computer with drive 'C:' is best) as bound volume. To this please notice the chapter Damage of
the bound volume or buying a new computer.

How to find out the serial number of the volume of your choice

The serial number of a volume is a multi-digit hexadecimal number (containing digits from 0 to 9
and letters from a to f, e.g. 45e78fa2). Note down the hexadecimal number without any special
characters like spaces, hyphens.

To find out the serial number of the volume of your choice:

1. If the volume is a removable volume/disk insert the volume into the correct drive.

2. In Windows open a command line dialog window using the command sequence 'Start » All
Programs » Accessories » Command Prompt'

3. In the command line dialog window enter the command 'vol C:' (complete with ENTER), then
the serial number of drive 'C:' is displayed. Note: In the previously mentioned command you
have to replace the drive letter 'C:' by the letter of the drive containing the bound volume you
have choosen, if necessary.

4. In the command line dialog window enter the command 'exit' to close the dialog window.

What to do after reorganization of the drive letters of your computer

Please notice, the license is bound only to the serial number of the volume and not to the drive
letter. Therefore, you can reorganize the assignment of the drive letters of your system to the
volumes/drives of your computer at any time.

After reorganization you merely have to enter the new drive letter of the bound volume into the
input field Dongle Port of the 'License Activation' dialog of the application and to repeat the license
activation, to ensure the license to be valid.

What to do on damage of the bound volume or when buying a new computer

On damage or lost of your bound volume you can request for a free follow-up license. The same
is applied to if you have bound your license to a fixed mounted volume/disk of your computer
(e.g. the hard disk of your computer with drive letter 'C:') and now want to substitute a new
hardware for this volume/disk or the entire computer (e.g. you buy a new computer), provided
that you uninstall the program from your old volume/disk or computer.

HM Find+Rename USER MANUAL Page 80 of 88



To request your free follow-up license send an email to the Product Support containing the
following information: your full name and address, your valid email address, program name,
version number, the old license number, the reason for the follow-up license (e.g. damage/lost of
the bound volume, buying a new computer, ...), a confirmation that the program with the old
license has been uninstalled or is no more usable due to a damaged bound volume, as well as the
drive letter and serial number of your new bound volume/disk.
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Overview

e Order / Payment
e Delivery
e Activation
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Subject of the Contract of Sale

On paying the purchase price (registration fee) you purchase a user license for the full version of
the program. The terms of the enclosed End User License Agreement are effective upon
installation of the software.

Purchase Price / Registration Fee

The price indicated in the various download archives of the Internet is a target price. Dependent
on currency exchange rates and the currentness of the web pages in the download archives the
real price can differ slightly from this target price.

For the currently valid purchase price refer to the Online Product Page =@ in the Share*It!
Online Shop.

Order / Payment

For order and payment of a single user license you can choose between the ways mentioned
below. Each of these ways offer different types of payment. The purchase price is independent of
the type of ordering and payment you select.

If you want to use the program on multiple workstations you should request for information about
the low-cost and easy to handle multi-user licenses. Send your email request directly to the
HMSE Sales.

Companies within the European Union can order tax-free by using their VAT-No.
Order Types
Ordering via Share*It! / Digital River

Sharelt is a world-wide acting software distribution company selling the software of many
software developers as a reseller. Which means, when selecting this way of ordering the contract
of sale is made between you and Sharelt. Likewise, accounting and payment processing is handled
by Sharelt.

Sharelt offers a fast online order and you can order by email, letter, phone or fax too. For
payment you can choose between a multitude of payment types (all possible credit cards,
transfer, check, cash, online payment, PayPal) and currencies.

P Further information on ordering at Sharelt

Ordering Directly at the Software Developer

Residents within the European Community can order directly at the software developer HMSE.
When selecting this way of ordering the contract of sale is made between you and HMSE. In this
case accounting and payment processing is handled by HMSE.

You can order by email, letter, phone or fax. Please note, when using this way of ordering,
accounting and payment processing is possible in Euro solely. You can choose between the
payment types EU standard transfer, collection only check or cash. Payment by credit cards is not
possible.

Note: Companies, organisations and public institutions which are residents within the European
Community and which are only allowed to buy on account due to existing regulations and legal
provisions, should choose this way of ordering.

P Further information on ordering at HMSE
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Order Procedure

Detailed information on the order and payment procedure at Sharelt you will find online in the
Sharelt Customer Care Center =+@.

If you have questions beyond or need further information please contact Sharelt directly:
register@shareit.com.

Possible Types of Ordering
43 Online Order via Internet: Online order form =@

Ordering online is the fastest way to order the program and is handled via secure web
pages. All information needed for ordering is available directly in the online order form and
you can choose between different currencies, payment types, and so on.

Alternative to the link above, to display the online order form you can go to www.shareit.com
-+ and enter the Sharelt Program Number into the input field 'searching for programs' at the
bottom left of the screen.

Order by Letter/Fax/Email: Orderform for printing
Fill in the order form completely and send/fax/mail it to:

Sharelt! / Digital River GmbH Phone: +49-221-31088-20

Scheidtweilerstr. 4 Fax: +49-221-31088-29
50933 Koeln Email: register@shareit.com
Germany Internet: www.shareit.com =@

&3 order by Phone: +49-221-31088-20
Employees of the Sharelt call center, Koeln, Germany, will accept your order.

Customers in the United States and Canada may also order by calling the toll-free number
1-800-903-4152 of the US call center of Sharelt around the clock.
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Order Procedure

Due to organizational reasons this way of ordering is possible only for residents
within the European Community.

To order directly at the software developer HMSE send your order by email, letter, phone or fax
to:

Dipl.-Ing. Martin Haller Phone: +43-5372-68504
Software-Engineering & EDV-Beratung Fax: +43-5372-68504
Langkampfner Strasse 19 Email:  see product information
6330 Kufstein / Austria Internet: see product information

Your order should contain the following ordering data:

e Your name, address and email:
Giving a valid email address is absolutely obligatory because the whole order procedure and
delivery will be made by email.

e Your VAT number (only for companies within the EU, if available).

e The payment type you want:
You can choose between the following payment types: EU standard transfer, collection only
check or cash. If you want an other payment type, please select an other order type.

¢ Name and version number of the program:
See the product information for these data.

e The number of licenses you want to order:
You need a license for each computer you want to install and use the program.

e The registration data the license should be made out, once for each license ordered. For
further information see here.

To simplify the procedure you can use the enclosed order form, print it and fill it out.

Order Confirmation

After receipt of your order you will receive an order confirmation by email containing an unique
order number, the total amount to pay as well as further information on the payment type you
have selected (bank infos, and so on).

Payment

Please understand, due to organizational reasons we can accept your payment in Euro only. If you
want to pay in an other currency please select an other order type. Possible exchange and transfer
costs of the payment process are at your expense. To speed up the order processing it is
important to give the order number from the order confirmation you have received as
additional payment information.

Please note, that the contract of sale will not become operative until receipt of payment of the full
total amount indicated in the order confirmation. Payment before delivery is world-wide the
common practice when ordering shareware.

Buy on Account

This order type is intended for companies, organisations and public institutions only which are
residents within the European Community and which are only allowed to buy on account due to
existing regulations and legal provisions.

In this case please transmit your order containing your internal order number and signature and
the other ordering data (see above) in written form by letter or fax. After receipt and verification
of your order you will receive the delivery together with the order confirmation.
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In your order give the following registration data once for each license ordered:

e Username:
First name and last name of the licensee or other name.
¢ Organization (may be empty for privat persons):
Name of organization the licensee belongs to.
e Drive Letter:
Letter of the drive containing the 'bound volume', followed by a colon (:), e.g. 'C:".
You can see the drive letters of your computer in the Windows Explorer program.

e Volume S/N:
Serial number of the 'bound volume' as hexadecimal number (0-9, A-F).
How to find out the serial number of a volume (disk, data medium), please read here.
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After receipt of your order and payment you will receive your user license by email as soon as
possible (on online ordering usually within 2 days).

The delivery of the user license will take place in form of a license letter containing your license
number (activation code) and instructions how to activate the license and to convert the
shareware version of the program to it's full version.

Additionally, in the next days the vendor will send you an invoice and by cash with order a
confirmation of receipt of payment.

Note:

The program itself (the software) you have already downloaded to your computer, installed and
tested as shareware version. As the shareware version is identical with the full program version,
the software is not delivered once again. On activation of the shareware version all restricted
program features are unlocked so that you can use the full programm unrestrictedly.

If you have not yet installed the shareware version of the program on your computer you can
download it from the Product Homepage or from other shareware web sites.
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To activate a license with the unregistered shareware version of the application:

1. Under Windows NT/2000/XP and all later versions of Windows log in to your computer with an
administrator account.

Note: To find out which user account of your computer is an administrator account, open User Accounts in Windows
Control Panel. Then if needed, restart your computer and log on to Windows with an administrator account.

2. If the volume (disk, data medium) you have specified in your order to bind the license to is a
removable disk, insert it now into the correct drive.

3. Open the Windows Start menu and click "All Programs’, click the program group of the
application and then the program shortcut 'License Activation’'.

4. In the License Activation window click the button 'Start' to open the 'License Activation'
dialog.

5. In the 'License Activation' dialog enter all license information exactly the same as specified in
the license you have got from the licenser. Note, the values are case-sensitive.

6. Click the button 'Check license'. A message box will display the validity of the license. Close
the message box.

Note: If the message box shows that the license is invalid, verify the license information you have entered and correct
them if needed. Verify the inserted bound volume to have the correct serial number. If the drive letter of the drive
with the bound volume has changed since ordering the license, enter the new drive letter. Then repeat the license
check.

7. Close the 'License Activation' dialog with 'OK' by what a valid license is activated only.
8. Restart the application as usual. All of its features are unlocked now.
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